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Copyright and Legal Notice
Copyright © 1998-2018 Dialogic Corporation. All Rights Reserved. You may not reproduce this document in whole or in 
part without permission in writing from Dialogic Corporation at the address provided below.
All contents of this document are furnished for informational use only and are subject to change without notice and do not 
represent a commitment on the part of Dialogic Corporation and its affiliates or subsidiaries ("Dialogic"). Reasonable effort 
is made to ensure the accuracy of the information contained in the document. However, Dialogic does not warrant the 
accuracy of this information and cannot accept responsibility for errors, inaccuracies or omissions that may be contained 
in this document.
INFORMATION IN THIS DOCUMENT IS PROVIDED IN CONNECTION WITH DIALOGIC® PRODUCTS. NO 
LICENSE, EXPRESS OR IMPLIED, BY ESTOPPEL OR OTHERWISE, TO ANY INTELLECTUAL PROPERTY RIGHTS 
IS GRANTED BY THIS DOCUMENT. EXCEPT AS PROVIDED IN A SIGNED AGREEMENT BETWEEN YOU AND 
DIALOGIC, DIALOGIC ASSUMES NO LIABILITY WHATSOEVER, AND DIALOGIC DISCLAIMS ANY EXPRESS OR 
IMPLIED WARRANTY, RELATING TO SALE AND/OR USE OF DIALOGIC PRODUCTS INCLUDING LIABILITY OR 
WARRANTIES RELATING TO FITNESS FOR A PARTICULAR PURPOSE, MERCHANTABILITY, OR 
INFRINGEMENT OF ANY INTELLECTUAL PROPERTY RIGHT OF A THIRD PARTY.
Dialogic products are not intended for use in certain safety-affecting situations. Please see 
http://www.dialogic.com/company/terms-of-use.aspx for more details.
Due to differing national regulations and approval requirements, certain Dialogic products may be suitable for use only in 
specific countries, and thus may not function properly in other countries. You are responsible for ensuring that your use of 
such products occurs only in the countries where such use is suitable. For information on specific products, contact 
Dialogic Corporation at the address indicated below or on the web at www.dialogic.com.
It is possible that the use or implementation of any one of the concepts, applications, or ideas described in this document, 
in marketing collateral produced by or on web pages maintained by Dialogic may infringe one or more patents or other 
intellectual property rights owned by third parties. Dialogic does not provide any intellectual property licenses with the 
sale of Dialogic products other than a license to use such product in accordance with intellectual property owned or validly 
licensed by Dialogic and no such licenses are provided except pursuant to a signed agreement with Dialogic. More detailed 
information about such intellectual property is available from Dialogic's legal department at 3300 Boulevard de la Côte-
Vertu, Suite 112, Montreal, Quebec, Canada H4R 1P8. Dialogic encourages all users of its products to procure all 
necessary intellectual property licenses required to implement any concepts or applications and does not 
condone or encourage any intellectual property infringement and disclaims any responsibility related 
thereto. These intellectual property licenses may differ from country to country and it is the responsibility of 
those who develop the concepts or applications to be aware of and comply with different national license 
requirements.
Dialogic, Dialogic Pro, Brooktrout, BorderNet, PowerMedia, PowerVille, PowerNova, ControlSwitch, I-Gate, Veraz, 
Cantata, TruFax, and NMS Communications, among others as well as related logos, are either registered trademarks or 
trademarks of Dialogic Corporation and its affiliates or subsidiaries. Dialogic's trademarks may be used publicly only with 
permission from Dialogic. Such permission may only be granted by Dialogic's legal department at 3300 Boulevard de la 
Côte-Vertu, Suite 112, Montreal, Quebec, Canada H4R 1P8. Any authorized use of Dialogic's trademarks will be subject to 
full respect of the trademark guidelines published by Dialogic from time to time and any use of Dialogic's trademarks 
requires proper acknowledgement.
The names of actual companies and products mentioned herein are the trademarks of their respective owners.

http://www.dialogic.com/company/terms-of-use.aspx
http://www.dialogic.com/company/terms-of-use.aspx
http://www.dialogic.com
http://www.dialogic.com
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Hardware Limited Warranty
Refer to the following Dialogic web site for information on hardware warranty information, which applies unless different 
terms have been agreed to in a signed agreement between yourself and Dialogic Corporation or its subsidiaries. The listed 
hardware warranty periods and terms are subject to change without notice. For purchases not made directly from Dialogic 
please contact your direct vendor in connection with the warranty period and terms that they offer.

http://www.dialogic.com/warranties

http://www.dialogic.com/warranties
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About this Publication

This Dialogic® Brooktrout® Fax Products Windows End User Guide 
is for users running either of the following in a Windows 
environment:

 Dialogic® Brooktrout® SR140 Fax Software

 Dialogic® Brooktrout® TR1034 Series and Dialogic Brooktrout® 
TruFax® boards.

Refer to the Dialogic® Brooktrout® Fax Products Linux End User 
Guide if you operate in a Linux environment.

This document contains the following chapters:

 Chapter 1 explains how you get started installing and 
configuring Dialogic® Brooktrout® software and hardware in a 
Windows environment.

 Chapter 2 explains how to install your Dialogic® Brooktrout® 
TR1034 Series and Dialogic® Brooktrout® TruFax® boards.

 Chapter 3 describes how to activate Dialogic® Brooktrout® 
SR140 Fax Software using the Dialogic® Brooktrout® License 
Manager.

 Chapter 4 describes how to configure the Dialogic® Brooktrout® 
Fax Software with Dialogic® Brooktrout® SR140 Software and 
TR1034/TruFax boards.

 Chapter 5 explains testing the Dialogic® Brooktrout® SR140 
Fax Software and Dialogic® Brooktrout® TR1034/TruFax® 
boards.

 Chapter 6 provides specifications for Dialogic® Brooktrout® 
SR140 Fax Software and Dialogic® Brooktrout® 
TR1034/TruFax® boards.
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Manual Conventions

This manual uses the following conventions:

 Italics denote the names of variables in the prototype of a 
function, and file names, directory names, and program names 
within the general text.

 The Courier font in bold indicates a command sequence entered 
by the user at the system prompt, for example:

cd /Brooktrout/Boston/bfv.api

 The Courier font not bolded indicates system output, for 
example: 

C:>Files installed.

 The Courier font also denotes programming code, such as C and 
C++. Programming code appears in program examples.

 Bold indicates the data type of the prototype of a function, 
Dialogic® Brooktrout® Bfv API functions, dialog boxes, dialog 
box controls, windows, and menu items.

 Square brackets [ ] indicate that the information to be typed is 
optional.

 Angle brackets < > indicate that you must supply a value with the 
parameter.

.

The Caution icon is used to indicate an action that could cause harm to 
the software or hardware.

The Warning icon is used to indicate an action that could cause harm to 
the user.

Related Documents
For product information, white papers, FAQs, and more, access the 
Dialogic web site at www.dialogic.com.
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SR140 Telephony Requirements

Physical Media Call Control

Ethernet 10/100 T.38 v0 or v3

RTP V2 G.711

H.323
SIP 
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Terminology

Updated Terminology
The current version of this document includes terminology that 
differs from previous versions. Please note the changes below:

Former Terminology Replaced with...

Host-based fax Dialogic® Brooktrout® SR140 Fax Software

or 

Brooktrout SR140 Fax Software 

or

SR140 Software

or

SR140

Virtual modules

Virtual boards

Software modules

VoIP modules

SR140 virtual modules

TR1000 Series SDK Dialogic® Brooktrout® SDK

TR1000 Series Product Dialogic® Brooktrout® Fax Board 

or 

Brooktrout fax board

or

board

TR1000 Series Module

TR1000 Series Board

Brooktrout System Software Dialogic® Brooktrout® Runtime Software
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Dialogic® Brooktrout® TR1034 Fax Board Terminology
The Dialogic® Brooktrout® TR1034 Fax Board is also referred to 
herein by one or more of the following terms, or like terms including 
“TR1034”:

 Brooktrout TR1034 Fax Board

 Brooktrout TR1034 Board

 TR1034 Fax Board

 TR1034 Board



Getting Technical Support

April 2018 12

Getting Technical Support

Dialogic provides technical services and support for customers who 
have purchased hardware or software products from Dialogic. If you 
purchased products from a reseller, please contact that reseller for 
technical support.

To obtain technical support, please use the web site below:

www.dialogic.com/support



April 2018 13

1 - Getting Started

This chapter provides an introduction and quick start installation 
instructions for installing the Dialogic® Brooktrout® software and 
hardware in a Windows environment.

Refer to the Dialogic® Brooktrout® SR140 Fax Products Linux User 
Guide if you operate in a Linux environment.
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Fax Board and Virtual Modules (SR140)

Dialogic’s intelligent fax board platform, the Dialogic® Brooktrout® 
TR1034 Fax Board, provides Dialogic ISV (Integrated Software 
Vendor) partner’s fax application with the capability to communicate 
from their application to the telephone or IP network.

For software-only systems using IP only, Dialogic implemented the 
SR140 as a virtual module. Although it is software, the SR140 
appears to the fax application just like a board. That helps simplify 
your fax application publisher to provide a single product that works 
for hardware and software.



SR140 Product Family

April 2018 15

SR140 Product Family

There are two major SR140 products, the original full SR140 and the 
SR140-L. Each product differs in the available functionality, with 
the full SR140 having the highest functionality. The tables below 
summarize the feature set available for the different SR140 products 
over the course of their release history.

Note: Full SR140 and SR140-L licenses cannot co-exist in the same 
system.

Table 1.   Full SR140 Release History

Release Date Example Model Name Feature Set

R1 March 2008 SR140-4F  T.38 V.17

 Advanced Fax (Very High Res, 
MMR, JBIG/Color pass-
through)

R2 February 
2009

SR140-4F-V.34  T.38 V.34

 T.38 V.17

 Advanced Fax (Very High Res, 
MMR, JBIG/Color pass-
through

R3 April 2010 SR140-4-R3  G.711 RTP

 IVR

 T.38 V.34

 T.38 V.17

 Advanced Fax (Very High Res, 
MMR, JBIG/Color pass-
through
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Table 2.   SR140-L Release History

Feature Pack Licenses
Feature pack licenses are available to allow you to add features 
matching a later release. The feature pack license is added to your 
existing license to bring you up to the latest set of available features. 

For example, if you currently own an original SR140 R1 (SR140-4F), 
you can obtain an upgrade pack license (SR140-FeaturePack-4-R3) 
that will add in the new features, without first requiring an R2 
feature pack license.

Release Date Example Model Name Feature Set

R1 April 2010 SR140-L-4-R1  Maximum eight channels per 
system

 T.38 V.17

 Advanced Fax (Very High Res, 
MMR, JBIG/Color pass-
through)



SR140 Product Family

April 2018 17

Upgrade Licenses
Upgrade licenses allow you to add the feature set of the full SR140 to 
the SR140-L.  The upgrade license is added to your existing license 
to bring you up to the latest set of available features.  

For example an SR140-L-2-R1 together with a SR140-L-UPGRADE-
SR140-2-R3 will have the same features as an SR140-2-R3.

Demonstration Licenses
Demonstration licenses are available for both the SR140 and 
SR140-L. Demonstration licenses will cause each transmitted or 
received page to be overlaid with the word 'Demonstration'. Only one 
demonstration license can be installed in a system at any time and 
cannot be used together with non-demonstration licenses.

Demonstration licenses expire after some time period, typically 30 
days from when the license was first activated. The License Manager 
displays when a demonstration license is due to expire. If a 
demonstration license expires, it will cause the SR140 to stop 
functioning. You will need to delete any demonstration licenses that 
have expired before you can use a nondemonstration license.  You 
may delete the demonstration license using the License Manager or 
manually.
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Software Licenses

The SR140 Virtual Module is delivered together with your fax 
application. The SR140 license is the right to use the software 
products in an entitlement purchased from Dialogic. The license is 
represented by the contents of a License File that is used by the 
software to restrict use to that entitlement. When you install the 
software, you acknowledge the License Agreement that governs 
SR140 licensing. 

A License Key is delivered in paper form or electronic form and 
shows you what your entitlement is, and provides a License Key to 
allow you to apply your entitlement to a computer system when you 
install the SR140 Fax Software.

Make sure to keep your License Key certificate in a safe place, where 
you can find it easily.

Product Activation

As well as helping you stay within your entitlement, your SR140 Fax 
Software product uses copy protection technology. Following 
installation of the software, Product Activation is a process for tying 
a license to a particular system, limiting use of that licensed 
software to one computer system.  Product Activation is simple and 
may be completed via the License Manager, the Internet, email or by 
fax and involves supplying your License Key shown on the License 
Key certificate and a unique identifier of the computer system that 
can be used to lock a license to a computer (known as node-locking).

Configuration
All modules - virtual modules or real boards - need to know how to 
handle call control over the IP network. Once you have installed the 
software and activated your product, you need to enter settings that 
control how connections are made between the IP network and the 
virtual module. This process is called configuration.
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Getting it Working
Follow the steps below to get your Brooktrout fax hardware and/or 
software working.

 Hardware Installation

See Installing Dialogic® Brooktrout® TR1034 and TruFax® 
Hardware on page 20

 Product Activation

See Activating Dialogic® Brooktrout® SR140 Software on 
page 26.

 Configuration

See Configuring Dialogic® Brooktrout® SR140 Software and 
TR1034/TruFax® Boards on page 63.

 Test

See Testing Dialogic® Brooktrout® SR140 Software and 
TR1034/TruFax® Boards on page 129.
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2 - Installing Dialogic® Brooktrout®
TR1034 and TruFax® Hardware

This chapter applies to users of the Dialogic® Brooktrout® TR1034 
Series and Dialogic® Brooktrout® TruFax® boards. This chapter 
does not apply to users of the Dialogic® Brooktrout® SR140 Fax 
Software. 

For detailed hardware installation instructions, see the hardware 
installation card that came with your Brooktrout board. 
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Installation Overview

This section describes how to install your fax board on a Windows 
system.

If you already have the Dialogic® Brooktrout® Runtime Software 
installed and working on your system, do the following:

 Check your system to verify the minimum system requirements.

 Install your fax board. Refer to Installing Your Board on page 22. 

 If this is a new installation, install the Brooktrout Software. 

 Configure your Brooktrout board. Refer to Configuring 
Dialogic® Brooktrout® SR140 Software and TR1034/TruFax® 
Boards on page 63.

 Enter your dialing information.

 Verify the installation. Refer to Verifying Brooktrout Board 
Installation on page 23.
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Installing Your Board

Before installing your board, make sure you have assigned the board 
a unique module number. 

 Follow these instructions to install your Brooktrout board 
into your computer:

1. Power off your PC and any peripheral equipment connected to it.

2. Unplug your PC power cord.

3. Remove the outside cover of your computer. 

4. Open your computer and locate a free PCI slot in the computer 
chassis. 

5. Remove the slot cover.

6. Carefully align the Brooktrout board with the PCI slot and firmly 
seat the board into the slot.

7. Tighten the mounting bracket screw to secure the board to the 
chassis.

Warning: When installing the board, be sure that the mounting bracket is 
securely fastened to the chassis and the chassis is plugged into a 
grounded three prong plug. Improper chassis or bracket grounding can 
result in harmful or fatal electrical shock as well as component damage.

8. Replace the outside cover of your computer.

9. Use the cable supplied with your board and connect one end of the 
cable into the RJ-45 telephone connector on the board’s mounting 
bracket.

10. Plug the other end of the cable into the connector for your 
telephone service.

11. Reconnect your PC power cord, and power on your computer. 
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Verifying Brooktrout Board Installation
 Verify that the Brooktrout board is successfully installed 

in your system:

1. Click either:

 Control Panel, Administrative Tools, Computer Management 
 Control Panel, System, Hardware, Device Manager

The following screens appear, respectively.

2. After installing your Brooktrout fax board, allow Windows Plug 
and Play to locate and accept the device driver for the Brooktrout 
board. 

You must wait several moments while Windows Plug and Play 
performs board verification and driver installation. Do not use your 
mouse or press any keys on your keyboard during this time.
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Note: After installing the Plug and Play driver on a Windows 
system, click the small flag in lower right hand corner to open 
Action Center. The following dialog box appears:

Click Finish installing device software.
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Viewing Brooktrout Board Properties
 To view the board’s properties:

1. Double-click the board name in one of the screens, as shown in the 
above window. The Brooktrout TRxStream Board Properties 
dialog box appears.

2. Click the Device Details tab.

3. Click the Configure option to use the Brooktrout Configuration 
Tool to configure telephony.
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3 - Activating Dialogic® Brooktrout®
SR140 Software

This chapter describes how to activate a license for the Dialogic® 
Brooktrout® SR140 Fax Software.

The SR140 Fax Software functionality is protected against piracy 
and abuse by licensing technology that uses product activation. A 
License Key is sold to the user who exchanges the key for a license 
file during or after installing the software. The license file is tied to 
the system during activation by imprinting a unique system 
signature (a Node ID) on the license file, and is based on the 
machine's MAC address.

The License Key can either be a unique, paid-for license key that 
provides a perpetual license or a demonstration license key that 
results in software that provides limited support for a limited time. 
Both types of product - licensed as demonstration or paid-for - 
require activation. You have several ways to activate the product.

You can use the Dialogic® Brooktrout® License Manager application 
to verify information about current licenses and to add new licenses 
for your Dialogic® Brooktrout® products.
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The application also verifies the following:

 The signature of the license is not broken.
 The license is not expired.
 The Node ID of the license matches the Node ID of the computer 

(sometimes referred to as the “Node Lock” of the computer).
 The system clock is not set back.

Please contact Dialogic Technical Services and Support if you are 
unable to use the license. See Getting Technical Support on page 12.

This document has the following sections:

 Preparing for Activation on page 28.
 Using the License Manager on page 29.
 Activating a License Automatically on page 35.
 Activating a License Using the Web on page 40.
 Activating a License Using Email or Fax on page 46.
 Installing Licenses on page 48.
 Logging Information on page 50.
 Managing License Files on page 51.
 Removing Licenses on page 52.
 Re-installing a License on page 53 .
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Preparing for Activation

To use the License Manager to activate your Brooktrout product, 
perform the activation process from the system where the Dialogic® 
Brooktrout® SR140 Fax Software is installed. Once the license is 
activated, install the license file on that system (unless you activate 
automatically which does not require installation). 

Because the SR140 Fax Software is an IP-based technology, Dialogic 
uses the IP network and the Internet to perform Product Activation. 
Ideally, the system you are installing on should be connected to an 
IP Network and to the Internet.

However you activate, Dialogic strongly recommends that you 
archive the License Certificate and the License File once the product 
has been activated.

Automatic activation must be performed using the License Manager 
on the system which is to be licensed.

Note: Because the license verifies if the system clock has been set 
back, you should ensure that the system date is set correctly.
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Using the License Manager

The License Manager application is usually installed with your fax 
application.

 To start the License Manager, use one of the following methods:

 Start the License Manager from the Configuration Tool

 Select Start → Program Files → Brooktrout → 
Brooktrout License Manager

 If you accepted the standard location to install your software, 
double-click the brktlicmgr.exe file at the following location:
C:\Brooktrout\Boston\bin

Otherwise, go to the location where you chose to install the 
software and double-click the brktlicmgr.exe file.

The License Manager window appears. 

This window shows information for any installed licenses. The 
application tries to determine license integrity and authenticity.
Typical problems when validating licenses:
1. The license can have a broken signature.
2. The license can expire.
3. The license can have the wrong Node ID.
4. System clock can be tampered.
If the license has more than one problem, only the first detected 
problem is indicated. For example, if the license has expired and 
has a broken signature, only the broken signature is indicated on 
the main screen.
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Displaying and Copying Node IDs
There may be more than one MAC address on the system. If so, you 
can choose the MAC address in which to lock. The License Manager 
allows you to view the Node ID representation of the first 20 
Ethernet Adapter MAC addresses available on the system. 

You need to use this function in order to node lock to a MAC address 
in the system other than the default MAC address used for node 
locking. 

For information on node locking refer to Overriding the Default MAC 
Address Used for Node Locking on page 39.

 Follow the steps below:

1. From the Utilities menu, select Display all node IDs. A screen like 
the following appears.:

2. Double-click to select the Node ID. Right click and select Copy to 
copy the Node ID.
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Displaying and Copying Node ID 
  Follow the steps below to display and copy a Node ID 

(referred to as Node Lock in the screen below).

1. From the Utilities menu, select Display Node Lock. A screen like 
the following appears:

2. Double-click to select the Node ID. Right click and select Copy to 
copy the Node ID.
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Starting the License Activation Wizard

 Start up the License Activation Wizard by selecting 
Activate License from the License menu.

1. Select License -> Activate license... 
If a Demonstration License Key file (.dlk) file is located, then the 
License Activation Wizard Welcome dialog below appears. If no 
Demonstration License Key file (.dlk) is located, the Welcome 
Dialog (no .dlk file) on page 33 appears:

The .dlk file (Demonstration License Key file) contains a license 
key for the SR140 demonstration mode. The user's application 
can provide such a file. It will then be located in the same 
directory as the License Manager executable. The .dlk file gets 
read only when the License Manager is initially launched. Do not 
edit this file while the License Manager is running.

2. Select Use license key provided with my application to 
activate the demonstration license. If you would like to enter a 
purchased license key then select Enter externally provided 
license key. 
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Welcome Dialog (no .dlk file)

3. Click Next. The Activation Method dialog box appears:

4. Select an Activation Method.

 Automatically (this computer is connected to the Internet)

Activates licenses automatically to the machine performing 
the activation. This is the easiest method if your computer is 
connected to the Internet. If successful, this step completes 
the product activation process immediately. Your new license 
files are displayed in the License Manager main window.
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See Activating a License Automatically on page 35.

 Using the interactive web method

Activates licenses using the Dialogic License Activation 
website. After successfully processing activation information, 
you can choose to download the file immediately or have the 
license emailed to you. Within a couple of minutes Dialogic 
sends an email containing a license file, if you select to have 
the license emailed to you. To complete the activation process, 
use the License Manager interface to install the license file(s) 
on the machine specified. 

See Activating a License Using the Web on page 40.

 Create a request for email or fax

See Activating a License Using Email or Fax on page 46. After 
successfully processing activation information, Dialogic 
sends an email containing a license file. To complete the 
activation process, use the License Manager interface to 
install the license file(s) on the machine specified in the 
email/fax activation request. Dialogic sends a license in about 
one working day.
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Activating a License Automatically

 To activate a Brooktrout license using the automatic 
activation method, follow the steps below:

1. Select the automatic activation option above.

If you chose the option Use license key provided with my 
application on the Welcome dialog then skip to step 5 below. 

If you chose the option Enter externally provided license key 
on the Welcome dialog or there was no .dlk file located when the 
License Manager was launched, then the License Keys dialog 
appears:

2. Select the Add button to enter all purchased License Keys one at 
a time. 
You can enter more than one License Key. You must enter at least 
one License Key to proceed, otherwise an Error dialog box 
appears.

This License Key can be found on your Licence certificate. The 
License Key is a variable length ASCII string. An example of such 
a key is: BRKT111-1234567

Note: Click the Edit button if you need to correct the License Key 
information. Click the Delete button if you need to delete 
license key information. 
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3. The Please enter License Key dialog box appears:

4. Enter the License Key and Click OK.

5. The Product Registration window appears:

For your convenience, Product Registration follows activation in the 
same session using the License Activation Wizard. 

6. Follow the screen prompts if the Product Registration window 
appears.

All but one of the registration fields are required (indicated by an 
asterisk [*]). When required information is not entered, an Error 
dialog box is displayed. Be sure to enter the information for the 
person responsible for the day-to-day running of the installation.
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7. Verify that your computer is connected to the Internet.

8. Click Next to begin processing your license request.

The License Manager sends the license request to the Dialogic 
License Activation Center, where your license request is 
processed.
The request process can take a few minutes.

9. The Request Status window appears when the automatic 
activation process is complete. The License Manager provides a 
Tip when license activation fails. The Tip usually provides a 
possible solution or where to get more information that leads to a 
solution:

 License Obtained

The requested license is automatically installed in your 
system. The product activation process is complete.

 Request Failed. Invalid license key.

The following is the tip associated with this failure:

Tip: The license key you are trying to activate is not valid. 
Please confirm the license key was entered accurately into 
the License Activation Wizard.

When a License Key is invalid because of a data-entry error, 
re-enter the correct license key by running the License 
Activation Wizard again. If the license key has been entered 
correctly but the request status is invalid, contact Dialogic 
Technical Services and Support. See Getting Technical 
Support on page 12.

 Request Failed. License already activated.

The following is the tip associated with this failure:

Tip: The license key you are trying to activate has already 
been activated. You cannot activate the same License Key on 
different systems. Please refer to your user documentation for 
details about moving licenses from one system to another or 
restoring lost licenses.

When you attempt to activate a license key for the second 
time from the same or another computer, it is considered re-
hosting. Please contact Dialogic Technical Services and 
Support for solutions to this problem. See Getting Technical 
Support on page 12.
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Also see Managing License Files on page 51 for more 
information.

 Request Failed. Cannot communicate with the License 
Activation Center.

The following is the tip associated with this failure:

Tip: The License Activation Center cannot be reached. Please 
check your Internet connection, network and firewall 
settings. Please try again. You can also restart the License 
Activation Wizard. Select either the option to use the 
interactive web method or the option to request a license via 
email or fax.

The License Activation Center cannot be reached because the 
License Activation Center computer is temporarily 
unavailable or you are experiencing temporary Internet 
problems.

Attempt to correct the problem and retry the request. When 
using the access numbers, if failures persist, contact Dialogic 
Technical Services and Support. See Getting Technical 
Support on page 12.

 Request Failed. Internal error code["err #"].

The following is the tip associated with this failure: 

Tip: Please try again. You can also restart the License 
Activation Wizard; select either the option to use the 
interactive web method or the option to request a license via 
email or fax.

If failures persist, contact Dialogic Technical Services and 
Support. See Getting Technical Support on page 12.

10. Click Next. 
The final License Activation Wizard window appears indicating 
which license keys have been activated and which license keys 
have failed activation.

11. Click Finish to complete your activation process.

Because you activated automatically, you do not need to install 
licenses. Your activation process is finished.
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Overriding the Default MAC Address Used for Node Locking 
Note: The follow procedure applies only to automated license 

activation.

In some cases, when you have multiple MAC addresses in your 
system, you may want to use a different MAC address other than the 
default MAC address used for node locking.

Create a file named brktlicmgr.cfg and place it in the same directory 
as the License Manager (for example, Brooktrout\Boston\bin). 

This file should be a text file with a single line
 ‘NodeID=<enter node id here>’, with no spaces.

 To obtain the node ID for the MAC address you intend to 
use follow the steps below.

1. Launch the License Manager.

2. From the Utilities menu, Select Display All Node Ids option.

3. Select the adapter.

4. Copy and paste into the brktlicmgr.cfg configuration file.

For details see Displaying and Copying Node IDs on page 30.
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Activating a License Using the Web

You can also activate your SR140 Fax Software license on the web 
using a computer that has web access. This can be a different 
computer than the server on which you are installing the SR140 
virtual module.

It is critical that you enter the Node Lock information for the intended 
machine (Node ID) on the website without errors. The software 
generates an unusable license when you enter incorrect Node Lock 
information. The second attempt to obtain the license using the corrected 
Node Lock information is considered re-hosting. In this case see
Re-Hosting License Files on page 57.

 Follow the steps below to activate a license using the 
interactive web method: 

1. Start up the license manager.

2. Select Using the interactive web method as your method of 
activation. 

The following License Activation Wizard window appears:
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3. Click Save the instructions into a file button. 

The instructions shown in the License Activation Wizard window 
are saved to a file that you can print or refer to at a later date. The 
instructions provide the Node Lock Type and the Node Lock that 
you enter when activating from the web.
You can also display the Node ID information by selecting Display 
Node Lock under the Utilities menu in the License Manager 
window.

4. On a computer that has Internet Access, enter the web address 
www.dialogic.com/activation, which directs you to a secure 
server. The following screen appears.

5. Enter your original License Key (this can be found on your 
License certificate) and click Submit. The following screen 
appears.

http://www.dialogic.com/activation
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6. Click Generate Licenses. The following screen appears.
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7. Select the Product you are activating. Select the Node ID Type 
and enter the Node ID. If you are using License Manager version 
2.0 or greater, select Node ID type VID. If you are using an earlier 
version than 2.0, select Node ID type COMPOSITE.

8. Click Generate License. 
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9. Verify that the information on this screen is correct and click 
Confirm. The following screen appears.

10. Click Save to File to save the license file to your computer or click 
Email to have the License file emailed to you. The following screen 
appears.
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11. Follow the instructions Installing Licenses on page 48 to install 
the license file. 
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Activating a License Using Email or Fax

When your system cannot support the previous options (for example, 
you have no Internet connections) you can activate your license by 
sending the information to Dialogic using email or fax.

Note: If you activate your license by email or fax, Dialogic will send 
you the license file in about one business day.

 To activate a license by Email or Fax, do the following:

1. Start up the license manager.

2. Select Create a request for email or fax as your method of 
activation. 

3. Click Next. 
The following License Activation Wizard License Key dialog box 
appears:
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 Select the Add button to enter all purchased License Keys 
one at a time. 
You can enter more than one License Key. You must enter at 
least one License Key to proceed, otherwise an Error dialog 
box appears.

The Please enter License Key dialog box appears (this License 
Key can be found on your License certificate, for example 
BRKT111-1234567):

4. Click Next and fill in the registration information as requested. 

5. Click Next.
The Email/Fax Request dialog box appears:

6. Click the Save the request into a file button to save all information 
entered into the Product Registration dialog boxes to a text file.

7. Email the saved file to activation@dialogic.com as an attachment, 
or fax this information to +1 781-433-2350 at the Dialogic License 
Activation Center for processing.

When you receive the license file from Dialogic, go to Installing 
Licenses on page 48 to install it in the correct location.
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Installing Licenses

When you receive a license file from the Dialogic License Activation 
Center (via email or saved from the site) use the License Manager 
application to install the attached license. 

If you receive the license file via email, the licensing information is 
sent to you in the body of the e-mail. You must create a file with a 
.LIC extension and copy the licensing information from the e-mail 
into that file. If you save the license file from the site, you save the 
file to a temporary site as indicated in step 1 below.

Note: If you use the automatic activation method, you do not need to 
install licenses. Your activation process is finished.

 Follow the steps below to install a license:

1. Save the license file to a temporary location (for example, 
C:\Brooktrout\Boston\bin) on your hard drive. 

2. Start the License Manager by selecting the following:

 Start → Program Files → Brooktrout → Brooktrout License 
Manager

3. The License Manager window appears. 
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4. Select Install previously activated license… from the License 
menu. The following screen appears:

5. Browse to the location of the license file. 

6. Highlight the filename, then click Open to activate your product.

Note: When the application is installed, an environment variable is 
created called: BRKTD_LICENSE_FILE, which refers to a file 
directory used by the License Manager to store license files. 
For more information on environment variables, please refer 
to your operating system documentation.



Logging Information

April 2018 50

Logging Information

The License Manager always provides logging information when 
errors occur. The application logs all messages preceding the error 
condition as well as messages following the error event. This log is 
helpful to Dialogic Technical Services and Support when solving 
problems.

In addition, you can execute the License Manager with the /d or --
debug option. For example, run brktlicmgr /d in a command 
window. Then the application logs all the information about the 
installed licenses.

This text log file, called BrktLicMgr.log, is stored in the application 
directory. 
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Managing License Files

The section contains the following instructions to manage the license 
files:

 Naming License Files on page 52

 Backing Up Licenses on page 52

 Removing Licenses on page 52

 Re-Installing Your Product on page 54 

 Restoring License Files on page 55

 Re-Hosting License Files on page 57

You can find license files (*.lic) in the path specified by the following 
environment variable:

BRKTD_LICENSE_FILE

The License Manager typically stores the files in this path:

C:\Program Files\Common Files\Brooktrout\

If you remove Ethernet network cards from your system, the license files 
become invalid if the card has a license file node locked to it. To activate 
the products, re-host the licenses (see Re-Hosting License Files on 
page 57).

Note: If the ISV took the necessary steps, the license files are not 
removed when you remove the application using the uninstall 
option. 

Unless you manually remove the files, they are still located in the 
same directory as before, typically: 

C:\Program Files\Common Files\Brooktrout 
The environment variable BRKTD_LICENSE_FILE is removed 
when the Brooktrout software is uninstalled.

Do not copy other files into this directory. Doing so could 
result in the Configuration Tool reporting errors.
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Naming License Files
All license files end with the .lic extension. One file can contain one 
or more licenses. The license filename is usually in either form:  

dd-mmm-yyyy.lic 
dd-mmm-yyyy-x.lic (next available number)

However, the license filename can be any filename with a .lic 
extension.

Backing Up Licenses 
To back up licenses, copy all *.lic files from the directory into a safe 
location. Copying the license files back to the same directory restores 
the licenses.

Typical directory:
C:\Program Files\Common Files\Brooktrout\

The path to the directory containing the license files can be found in 
the environment variable:
BRKTD_LICENSE_FILE

Removing Licenses 
The License Manager provides the means to remove licenses.

 Follow the steps below to remove a license:

1. Start the License Manager by selecting the following:

Start → Program Files → Brooktrout → Brooktrout License Manager
2. The License Manager window appears.

3. Find the license key of the license you would like to remove. 

4. Left click the license. 

5. Select Remove selected license from the License menu or click 
the blue X with Remove... on the toolbar. A Confirm License 
Removal screen appears. 

6. If you are sure you want to remove the selected license, click Yes, 
otherwise click No. 
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7. A popup will appear indicating the license key and file name of 
the file which was removed.  

8. The selected file will be renamed from licensefile.lic to 
licensefile.lic.removed. This file is located in the directory which 
the environment variable BRKTD_LICENSE_FILE (typically 
C:\Program Files\Common Files\Brooktrout\) refers to. 

Re-installing a License
 If a license was removed using License Manager, you need 

to shut down License Manager and re-install the license 
manually as follows:

1. Select Exit from the License menu to stop the License Manager. 

2. Go to the directory that the environment variable 
BRKTD_LICENSE_FILE 
refers to and find the license file which was removed (typically 
C:\Program Files\Common Files\Brooktrout\). These files are 
in the format licensefile.lic.removed. 

3. If there is more than one file that has been removed, then you will 
need to open each of the removed files and locate the license key 
of the license which you would like to reinstall. 

4. Once you find the file to reinstall, rename the 
licensefile.lic.removed to licensefile.lic 

5. Restart License Manager by selecting the following:

Start → Program Files → Brooktrout → Brooktrout License Manager
6. The license appears in the license manager window. 

Replacing Lost or Unrecoverable Licenses
When a license is lost or not recoverable, get a new copy by going 
through the web activation process again. See Activating a License 
Using the Web on page 40.
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Re-Installing Your Product
If you want to simply re-install your product on the same computer 
system after upgrading or replacing your hard disk or any other 
upgrade that maintains your network card’s MAC address, you can 
use the same license file without having to re-activate your product.
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Restoring License Files
If anything ever happens to your computer that leads to corruption of 
your software and the License File, retrieving another copy is a 
simple procedure. To retrieve another copy of your License File,

1. Visit the Dialogic activation website at:
www.dialogic.com/activation

The following screen appears.

2. Enter your original License Key (this can be found on your 
License certificate) and click Submit. The following screen 
appears.
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3. Click View Licenses. The following screen appears.

4. In the Select Product window, select your product and then select 
the appropriate Node ID. Click View. The following screen appears. 

5. Click Save to File or click Email to have the License file emailed to 
you. Follow the instructions Installing Licenses on page 48 to use 
the License Manager application to install the license file. 
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Re-Hosting License Files
To allow you to upgrade your computer to a new system or recover 
from a network card failure, Dialogic allows you to “re-host” your 
licensed software from one computer system to another. This process 
involves returning your current license and receiving another one.

The activation center web site allows you to automatically re-host 
your licensed software one time without technical support. For 
subsequent re-hosts you will need to contact Dialogic Technical 
Services and Support.

 Follow the steps below:

1. Visit the Dialogic activation website at:
www.dialogic.com/activation

The following screen appears.

2. Enter your original License Key (this can be found on your 
License certificate) and click Submit. The following screen 
appears
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3. Click Re-host Licenses. The following screen appears.

4. Select your product and click Return to return the license to 
Dialogic. The following screen appears.
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5. Verify that the information on this screen is correct and click 
Confirm. The following screen appears.
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6. In the Select Product box click the product for which you are re-
hosting. Select the Node ID Type and enter the Node ID. The 
Node ID Type must be VID (Vendor Defined Node ID) if you are 
using License Manager Version 2.0 or later. (Go to the Help 
Menu, and click About ... if you are not sure of your version of 
License Manager.)
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7. Click Generate License. The following screen appears.

8. Click Confirm. The following license appears. 
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9. Click Save to File to save the license file to your computer or click 
Email to have the License file emailed to you. The following screen 
appears.

10. Follow the instructions Installing Licenses on page 48 to use the 
License Manager application to install the license file on the 
appropriate computer.
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4 - Configuring Dialogic® Brooktrout®
SR140 Software and

TR1034/TruFax® Boards

This chapter describes how to configure the following products:

 Dialogic® Brooktrout® SR140 Fax Software

 Dialogic® Brooktrout® TR1034 Series and Dialogic® 
Brooktrout® TruFax® Boards

Dialogic provides the following configuration methods: 

 Configuring in Wizard Mode on page 66 (adequate for most 
configurations)

 Configuring in Advanced Mode on page 92

However, this method has not been adapted by every ISV software 
package. Instead, when this method is not used by your ISV 
application, please skip this chapter and consult the documentation 
that comes with your ISV application for the configuration of the 
SR140 Fax Software.



Running the Dialogic® Brooktrout® Configuration Tool for the First Time

April 2018 64

Running the Dialogic® Brooktrout® Configuration 
Tool for the First Time

When you start the Configuration Tool for the first time, you may get 
a Preferences Dialog box pop up. Only change the locations for the 
various files used by the Configuration Tool when requested by your 
application. 
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When the Configuration Tool detects an IP-enabled device, it 
displays the Configure IP Stack dialog box. Check with your network 
administrator whether you will use the SIP or H.323 IP call control. 
If you don't know yet, select “Both (SIP and H323)” so that both 
protocol stacks get installed. 

 None - IP stack not installed

 SIP - SIP stack installed (default)

 H.323 - H.323 stack installed

 Both (SIP and H.323) - Both SIP and H.323 stacks installed.
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Configuring in Wizard Mode

This section describes how to use the Wizard Mode to configure 
Dialogic® Brooktrout® Fax Software. You can use Wizard Mode to 
get most typical systems up and running with minimal effort.

In Wizard Mode, after you answer the basic questions, the 
Configuration Tool does the following.

 Automatically creates the necessary configuration file

 Installs and starts the drivers, if required

 Starts the Boston Host Service

Wizard Mode requires that all the modules be of the same kind. All 
modules are configured identically, that is, the modifications to the 
configuration apply uniformly to all the modules. 

You can use Wizard Mode in a homogeneous configuration where:

 all the boards are of an identical type

or 

 the system contains only SR140 virtual boards. 

In a non-homogeneous configuration, the Configuration Tool will 
automatically start in Advanced Mode.

 To use Wizard Mode:

1. Start the Configuration Tool if it has not already been started by 
the Plug-and-Play installation procedure. See Returning to the 
Default Configuration on page 128.
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2. The Welcome window appears.

3. When the Welcome window appears, you can choose to click the 
Advanced Mode button or the Next button.

 Advanced Mode

If you select Advanced Mode, the Configuration Tool exits 
Wizard Mode and starts in Advanced Mode (see Configuring 
in Advanced Mode on page 92).

 Next

If you click the Next button, Wizard Mode continues and 
creates the necessary configuration file after you answer the 
basic questions.
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4. The System Report appears on the right-hand panel, then click 
Next. 

This example shows the information for a T1 board.

5. Click Next and the following screen appears if the system detects 
a board that supports both IP and PSTN.

6. If you want to configure IP call control, select Internet Protocol (IP) 
Network and refer to Configuring IP Call Control on page 69.
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If you want to configure PSTN call control, select Public Switched 
Telephone Network (PSTN) and refer to Configuring PSTN on 
page 88

Configuring IP Call Control
 Follow the steps below to configure IP Call Control:

1. The following screen appears either after you select Internet 
Protocol (IP) Network or if your system supports only IP Call 
Control.

2. Select SIP or H.323. Click Next and the following screen appears 
if your system is board-based. If your system is software based the 
following step is skipped.
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3. Configure the Ethernet Port for each board detected. Click Next. 
The following screen appears if the systems supports IPv4 and 
IPv6. IPv6 is only supported on the Dialogic® Brooktrout® 
SR140. If a Dialogic® Brooktrout® TR1034 is present in the 
system or using H.323, the dialog will not be available.
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4. Select the appropriate Internet Protocol supported by your 
provider. Click Next. The following screen appears if there are 
multiple IP Interfaces detected in the system. 

5. The IPv4 and IPv6 options are available based on what the 
system supports and the selected Internet Protocol preference. 
Note: If you are using IPv6, you must select the IPv6 Interface to 
configure where the IPv6 calls will be accepted. Select the IP 
Interface where the IP calls will be accepted or let the 
Configuration Tool choose the best available configuration. Click 
Next

6. Refer to one of the sections below depending on which protocol 
you want to configure:

 Configuring SIP Call Control Protocol on page 72

 Configuring H.323 Call Control on page 80
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Configuring SIP Call Control Protocol
The section contains the following procedures. 

Configuring Direct Routing by the Application on page 72

Configuring SIP Call Control with Gateway or IP-PBX on page 73

Configuring SIP Call Control with a Proxy Server on page 74

Configuring Direct Routing by the Application

If you chose to configure the SIP Call Control protocol the following 
screen appears:

 Follow the steps below to configure Direct Routing by the 
Application. 

1. Select Direct routing by the Application. 

2. There is no routing configuration required because the 
application routes the call. Click Next and refer to Configuring 
SIP Fax Setup on page 79
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Configuring SIP Call Control with Gateway or IP-PBX

If you chose to configure the SIP Call Control, the following screen 
appears.

 Follow the steps below to configure SIP Call Control with a 
Gateway or IP-PBX.

1. Select Automatic routing to a Gateway or IP-PBX. Click Next and 
the following screen appears.
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2. Enter the Primary Gateway. Click Next and refer to Configuring 
the SIP Registrar on page 77. 

Configuring SIP Call Control with a Proxy Server

If you chose to configure the SIP Call Control the following screen 
appears.



Configuring in Wizard Mode

April 2018 75

 Follow the steps below to configure SIP Call Control with a SIP 
Proxy Server

1. Select Dynamic routing by a Proxy Server. Click Next and the 
following screen appears.
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2. Enter the IP address of the Primary Proxy Server and select Yes 
if there are additional proxy servers to configure. Click Next and 
the following screen appears.

3. Enter the IP address of any additional proxy servers. Click Next 
and continue to the next step Configuring the SIP Registrar on 
page 77.
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Configuring the SIP Registrar

 When the screen below appears, you can configure a SIP 
Registrar. 

1. From the screen above, select Yes to set up a SIP registrar. Click 
Next and the following screen appears.



Configuring in Wizard Mode

April 2018 78

2. Complete the information on this screen and click Next. The 
following screen appears.

3. Select Yes to configure additional registrar servers. The following 
screen appears.

4. Enter the IP addresses of the additional registrar servers. Click 
Next and the following screen appears. Refer to Configuring SIP 
Fax Setup on page 79.
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Configuring SIP Fax Setup 

 When the screen below appears, you can configure Fax.

1. Configure the fax transmission and the configuration is complete. 
Click Next and refer to Applying Changes after the Configuration 
is Complete on page 86. 
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Configuring H.323 Call Control 
You can configure H.323 Call Control three ways:  

Configuring H.323 Direct Routing by the Application on page 80

Configuring H323 Call Control with a Gateway on page 81

Configuring H.323 Call Control with a Gatekeeper on page 82

Configuring H.323 Direct Routing by the Application

If you chose to configure the H.323 Call Control, protocol the 
following screen appears. 

 Follow the steps below to configure Direct Routing by the 
Application. 

1. Select Direct routing by the Application.

2. This is no routing configuration required because the application 
routes the call. Click Next and refer to Configuring H.323 Fax 
Setup on page 84.
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Configuring H323 Call Control with a Gateway

If you chose to configure the H.323 Call Control protocol the 
following screen appears.

 Follow the steps below to configure H.323 Call Control with a 
Gateway or IP-PBX.

1. Select Automatic Routing to a Gateway or IP-PBX. Click Next and 
the following screen appears.
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2. Enter the Primary Gateway IP address. Click Next and refer to 
Configuring H.323 Fax Setup on page 84.

Configuring H.323 Call Control with a Gatekeeper

If you chose to configure the H.323 Call Control protocol the 
following screen appears.
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 Follow the steps below to configure H.323 Call Control with a 
Gatekeeper: 

1. Select Dynamic Routing by a Gatekeeper. Click Next and the 
following screen appears.

2. Enter the IP Address of the Primary Gatekeeper. Click Next and 
the following screen appears.
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3. Select Yes to specify additional gatekeepers. Click Next and the 
following screen appears.

4. Enter the IP addresses of the additional gatekeepers. Click Next 
and refer to Configuring H.323 Fax Setup on page 84.

Configuring H.323 Fax Setup

 When the screen below appears, you can configure Fax. 
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1. Configure the fax transmission and the configuration is complete. 
Click Next and refer to Applying Changes after the Configuration 
is Complete on page 86.
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Applying Changes after the 
Configuration is Complete
 Follow the steps below to save apply the changes.

1. Click either Save and Exit, Help, Back, Apply, or Cancel.
 Save and Exit

 Save the configuration and Exit without initializing the 
modules.

 Help 
 Displays help for the Configuration Tool.

 Back
 Displays previous page.

 Apply 
 Saves the configuration and initializes the modules.

 Cancel
 Does not save the configuration and exits.
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2. Click Apply and the board is initialized and configured. The 
following screen appears. 
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Configuring PSTN
Protocol Options Dialogic recommends that you accept the defaults that are based on 

the modules the Configuration Tool identified in your system. In this 
example, the module uses the T1 ISDN protocol.

Note: In Wizard Mode all the ports of all the modules will be 
configured with the same port setting.

 Follow the steps below:

1. Click the Show Details >> button.

 Note the details of the protocol chosen by the Configuration Tool.

Protocol Details The protocol details appear in the panel below the Protocol Options. 
The options are dependent on the protocol chosen. 

This example displays the options for the T1 ISDN protocol. 
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See the Configuration Files in Volume 6 of the Dialogic® 
Brooktrout® Bfv API Reference Manual for more information about 
the protocol parameters. 

Note: In wizard mode all the ports of all the modules will be 
configured with the same port setting.

2. Click Next. 
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The following screen appears. 

3. Click either Save and Exit, Help, Back, Apply, or Cancel.

 Save and Exit
 Save the configuration and Exits without initializing the 

modules.
 Help 

 Displays help for the Configuration Tool.
 Back

 Displays previous page.
 Apply 

 Saves the configuration and initializes the modules.
 Cancel

 Does not save the configuration and exits.

4. The Finish window appears if you selected Apply.
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5. Click Finish to complete the configuration.
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Configuring in Advanced Mode

If you have different types of Dialogic® Brooktrout® modules in your 
system or you want to configure your identical modules differently, 
you must use Advanced Mode: 

 When the Dialogic® Brooktrout® Configuration Tool detects that 
you have different modules, it starts in Advanced Mode. 

 When you start the Configuration Tool in Wizard Mode, you can 
move to Advanced Mode immediately by clicking the Advanced 
Mode button.

The Advanced Settings parameters for all module types are 
presented in logical groups. The ordering of the groups is 
alphabetical. The ordering of parameters within a group is according 
to their relative importance.

Most parameters are hidden unless you click Show Advanced. 
Generally, a user does not need to change the advanced parameters. 
See Call Control Parameters on page 104.

Advanced Mode Window When you enter Advanced Mode, the Dialogic® Brooktrout® 
Configuration Tool - Advanced Mode window appears.
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Navigating in Advanced 
Mode

 To navigate in Advanced Mode use the menus and buttons on 
the tool bar and the tree view on the left panel of the dialog 
boxes. 

Select one of the following to view the accompanying right panel 
information: 

 Select Brooktrout to display the welcome window, if you are 
not already there. 

 Select Driver Parameters to display the Driver Parameters 
dialog box. 

For sample values, see Getting Help From the Dialogic® 
Brooktrout® Configuration Tool on page 96.

 Select BTCall Parameters to display the BTCall Parameters 
dialog box. 

For sample values, see Driver Parameters (All boards) on 
page 100.

 Select Call Control Parameters to display the Call Control 
Parameters dialog box. 

For sample values, see Call Control Parameters on page 104.

 Select IP Call Control Parameters to display the IP Call Control 
Parameters dialog box. 

For sample values, see IP Call Control Modules on page 110.



Configuring in Advanced Mode

April 2018 94

Show Advanced Button When a parameter panel (for example: Driver Parameters, BTCall 
Parameters, Call Control Parameters) has advanced settings, the 
Show Advanced >> button appears on the bottom right of the right 
panel.

Hide Advanced Button When you click Show Advanced, the Advanced Settings portion of the 
panel appears, and the Hide Advanced <<  button is displayed.

There can be more than one panel of parameter information for 
Advanced Settings.
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Click the Hide Advanced << button to remove advanced parameters 
from the screen view.

Note: Most users never need to alter the Advanced Settings 
parameter values. If you know these settings are incorrect, 
please contact Dialogic Technical Services and Support for 
more information. See Getting Technical Support on page 12. 
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Getting Help From the Dialogic® Brooktrout® Configuration 
Tool

The Dialogic® Brooktrout® Configuration Tool provides context 
sensitive online help for parameters. The Help displays the purpose 
and description of the parameter including the default value and 
range, if applicable. 

 Hold the cursor over the parameter input area to see a brief 
parameter description.
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 Right-click the parameter drop-down box to get a more complete 
definition for Configuration Tool parameters. 

The What’s This? popup menu appears:

 Left-click the What’s This? popup menu for a definition like the 
following. You can resize this text box, if necessary.
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 Select About from the Help menu to display the version and 
copyright information for the Brooktrout Configuration Tool. 
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Configuration Tool Menu
Advanced Mode Menus  The following menu items are available in the Advanced Mode 

window:

 The File menu allows you to exit from the configuration tool.

 The View menu allows you to choose the previous or next 
window.

 The Options menu allows you to:

 Choose to apply and/or save the configuration.

 Reconfigure the driver.

 Launch the Brooktrout License Manager.

 Configure the IP Stack.

 Set your preferences for the locations of the btcall.cfg and 
callctrl.cfg configuration files, the firmware, and log files.

The Preferences dialog box is shown in Returning to the 
Default Configuration on page 128.

 Display the toolbar.

 The Help menu provides the following options:

 Access to the Configuration Tool Help Index Contents tree.

 Access to the Configuration Tool Help Index tab where you 
can navigate through the Help index entries.

 Search tab where you can look for any text entry.

 About provides version and copyright information for the 
Brooktrout Configuration Tool.

Advanced Mode Buttons  The Advanced Mode window contains these buttons:

 Home button to go to the welcome window if you are not already 
there.

 Next and Back buttons take you to the next or previous pages, 
respectively.

 Save button saves your configuration.

 Apply button installs, starts or stops the Boston Host Service. It 
also saves your configuration to the appropriate configuration 
file.

If you modified driver parameters, it:

 Dynamically reconfigures the drivers on a Plug and Play 
(PnP) operating system.
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 Installs the Boston Host Service if the service is not 
installed.

 Stops the Boston Host Service if the service is not running.

 Starts the Boston Host Service.

 License button launches the License Manager (bkrtlicmgr.exe).

 Help button displays help for the Configuration Tool in any 
mode.

Driver Parameters (All boards)
Click on Driver Parameters (All Boards) in the left panel to display the 
Driver Parameters in the right panel. 
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Reconfigure Drivers Right-click on Driver Parameters (All Boards) in the left panel to 
reconfigure the driver. 

This option dynamically updates the driver parameters by calling 
reconfig on a PnP system.

BTCall Parameters (All boards)
Click on BTCall Parameters (All Boards) in the left panel to display 
the BTCall Parameters in the right panel. No BTCall Parameters 
need to be changed, except when debugging is required. The country 
parameter is not used for the SR140.
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Debugging Options
Debugging Disabled When debugging is disabled all the BTCall Parameters 

debugging-related parameters are grayed out.
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Debugging Enabled The Bfv API Debug file is the main Brooktrout log, capturing debug 
information about faxing.

When you enable Bfv API Debugging, you need to specify a file name 
to write the Brooktrout debug information to. You can even specify a 
second file name, and set the size of the first file so that a second file 
is created when the first file has reached the specified size. 

When you enable Bfv API Debugging, and you enable “Trace Bfv API 
Function Calls”, you will get the following info added to the log file:

 Trace the entry to each Bfv API function call.

 List the parameter passed into a function.

 Trace the exit from each Bfv API function call.

See the right panel for specific debug parameter information.

For more information about the Show Advanced >> button, see 
Driver Parameters (All boards) on page 100.

Note: Most users never need to alter the Advanced Settings 
parameter values.
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Call Control Parameters
Click Call Control Parameters in the left panel to display the Report 
tab in the right panel.

Report Panel The Report tab displays the Call Control Parameters port 
configuration information.
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Tracing Panel The Tracing tab displays the Call Control Tracing debug parameters. 
Turning the parameters on will create a call control trace, sometimes 
called ECC-trace, which captures all call related debug information, 
similar to call setup and call tear down of the SIP or H.323 call.

Do not change any of these parameters until you have consulted with 
Dialogic Technical Services and Support. See Getting Technical 
Support on page 12.
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Module Settings
Click the module name in the left panel tree view to modify 
information about each module.

SR140 modules, features and number of channels depends on the 
license installed on the user system. You can obtain, install, and 
update the license using the License Manager utility. When you 
have installed multiple licenses, you will still typically see only one 
SR140 module. So, licenses get added up to look like a single module.

Note: A special demonstration license is available in either a single- 
or two-channel configuration that will run for a 30 day period. 
Contact your Dialogic sales representative to obtain this 
license. 

Products with demonstration licenses run with limited 
functionality. Please note that only one demonstration license 
may be used at a time. Demonstration licenses have incoming 
and outgoing fax pages overlaid with a Demonstration 
watermark. Once a demonstration license is upgraded to a 
permanent license, there will be no watermark on the 
incoming or outgoing fax pages. You can upgrade the 
demonstration license to a permanent license by activating 
new license keys without having to re-install the software.
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The Apply button on the toolbar starts the Boston Host Service to 
initialize the module. See Advanced Mode Buttons on page 99.

The License button on the toolbar launches the License Manager 
(bkrtlicmgr.exe).

General Information Tab 
for SR140

Use this tab to query the SR140 Fax Software licensing. The 
following window shows a permanent license: 

The following window shows a demonstration license: 
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Virtual Module - Not 
Available

An SR140 module displays in the General Information tab even when 
there is no valid license installed.

To invoke the License Manager utility (brktlicmgr.exe), press the 
icon Use License Manager utility to install the license. 

Parameters Tab for 
SR140

The Parameters tab displays the call control module type, Media IP 
Interface and IP port number information. You have to choose the IP 
call control type and you have to set the IP Interface.
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IP Call Control Module

The options are SIP or H.323 as call control protocol for your IP 
calls. Choose the IP option to associate this Call Control Type 
with the Brooktrout virtual module. Please check with your IP 
provider. 

Media IP Interface

Specifies the identity of the device on the PC with the IP interface 
that the virtual module can use for sending Fax Over IP (T.38 and 
RTP) messages and Voice Over IP (RTP G.711) packets. Select 
the network card you want to use for your FOIP traffic and give 
this network card a static IP address. Contact your network 
administrator to assign a static IP address to this Ethernet port 
since DHCP- dynamic host configuration protocol is currently not 
supported by Dialogic. If DHCP is used on the interface it can 
work, but only when the IP address does not change while the 
SR140 virtual module is running. If you do not provide a value 
(blank string), the virtual module chooses the first interface in 
the PC to send its messages. The format for the value provided in 
this parameter is: The name of the IP device (Global Unique 
IDentifier (GUID)) followed by a colon (:) character followed by 
the index number of the device's IP address.
For example: {4D36E96E-E325-11CE-BFC1-08002BE10318}:0
Note: Currently, the Bfv API only supports the GUID 

information on Windows operating systems. 
Value Type:character string (up to 256 characters) 
Default:<blank> (the virtual module uses the first interface in 

the PC for sending IP messages)

Lowest IP Port Number

Specify the lowest IP port number that the module can use. Verify 
there is no overlap in the port range ([media_port_min] to 
[media_port_max]) for each available SR140 module using the 
same media IP address. Set this value to a value 999 below the 
value specified for the media_port_max parameter. Valid values 
are:
Range: 1024 - 64535
Value Type: decimal
Default: 56000 (sets this value as the lowest port number)
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Highest IP Port Number

Specify the highest IP port number that the module can use. 
Verify there is no overlap in the port range ([media_port_min] to 
[media_port_max]) for each available SR140 module using the 
same media IP address. Set this value to a value 1000 above the 
value specified for the media_port_min parameter. Valid values 
are:
Range: 2024 - 65535
Value type: decimal
Default: 56999 (sets this value as the highest port number)

IP Call Control Modules
 Click IP Call Control Modules on the left panel to display 

information about any IP-enabled modules:

IP Call Control Modules 
Details

Both SIP and H.323 are supported for the call control over IP.
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General Information Tab 
for SIP Stack

The General Information tab contains information about the library 
path, stack name, vendor name, and version number. 

General Information Tab 
for H.323 Stack 

When you select an H.323 stack to configure, the General Information 
tab displays, as shown in the following example:
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IP Parameters Tab for 
SIP Stack

The SIP IP Parameters tab allows you to set values for the following 
parameters. Most of these parameters do not need to be set; the 
defaults will work, but in practice, just like you configure the ID of a 
fax machine, you should set From value and Phone Number. 
However, if you have multiple NIC cards in your system, and you do 
not want to use the first NIC card for the SIP traffic, you need to 
specify the static (fixed) IP address of the NIC card you want to use 
for the SIP messages in the Contact name field. This IP address will 
typically be the same as the IP address selected under “Media IP 
Interface” in the Parameters tab under the SR140 module, which 
selects the NIC card for the FOIP traffic. If the local network has a 
SIP proxy server and a SIP registration server, please contact your 
network administrator to set the Primary Proxy Server and Primary 
Registrar Server. If you do not have a SIP proxy/registration server, 
you have to set Primary Gateway when your application is not 
setting this value already. 
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Contact Name

Set this parameter to the IP address of the network interface 
(NIC) in the machine that you want to use for the SIP messages. 
Here, you typically want to set the same IP address as the one 
selected under the Media IP Interface parameter in the 
IP Parameters tab under the SR140 module. When left blank, it 
defaults to the first network interface in the system.
When this parameter is set to its default value 
(sip_Contact=0.0.0.0), the SIP stack automatically attempts 
to find the IP address of the local host during initialization. If the 
host has not registered its host name, the SIP initialization 
process will fail and SIP calls will not be processed. To process 
SIP calls in this case, the value in the sip_Contact parameter 
must be specifically set to an IP address of one of the host network 
interface boards.
When set, this parameter must contain an IP address in the form:
xxx.xxx.xxx.xxx:PortNumber (port number is optional)
10.128.22.6:5060 (port number specified)
10.128.22.6:0 (no port number specified)
Note: For the SIP protocol, the port defaults to 5060 if not 

specified.
This parameter can also be specified with an optional name prefix 
as shown in the following examples:
Name@xxx.xxx.xxx.xxx:PortNumber

username@10.128.22.6:5060

username@10.128.22.6

Range:0 – 255 for each dotted decimal position of the IP address.
1 – 65535 for the port number
Value Type:dotted decimal
Default:0.0.0.0:0 (system uses the IP address of the local host 

and port 5060)
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Primary Gateway

This parameter specifies the IP address of a default gateway to 
use for outbound calls. If a user only specifies a phone number 
when making a SIP call and the application is not using a SIP 
proxy server, the API forwards the call to the gateway specified 
with this parameter. The API forwards the specified phone 
number to the gateway for routing purposes. The API does not 
use this parameter if the configuration file specifies a 
sip_registration_server or sip_proxy_server.
When set, this parameter must contain an IP address of type 
IPv4, IPv6, or Hostname in the form:
xxx.xxx.xxx.xxx:PortNumber

hostname:PortNumber

10.128.22.6:5060 (port number specified)
10.128.22.6 (no port number specified)
Note: For the SIP protocol, the port defaults to 5060 if not 

specified.
Range:0 – 255 for each dotted decimal position of the IP address.
1 – 65535 for the port number
Value Type:dotted decimal
Default:0.0.0.0:0 (no default gateway defined)
The Bfv API does not use this parameter if the configuration file 
specifies a sip_registration_server or sip_proxy_server.

Description URI

Indicates the value used for the u= line in the SIP SDP. The 
u= line identifies the SIP uniform resource identifier (URI) of the 
session description. Valid values are:
Range: 1 - 255 characters
Value Type: character string (up to 256 characters)
Default: <blank> (empty string)
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Email Address

Indicates the value used for the e= line in the SIP SDP. The 
e= line identifies the email address of the person or entity 
responsible for the session. Valid values are:
Range: 1 - 255 characters
Value Type: character string (up to 256 characters)
Default: <blank> (empty string)

From Value

Indicates the value provided in the SIP header for the From field. 
The From field contains a display name and a SIP uniform 
resource identifier (URI) or SIPS (secure SIP) URI that identifies 
the originator of the session request. So, set the SIP address of the 
SR140 Fax Software here. Valid values are:
Range: 1 - 255 characters
Value Type: character string (up to 256 characters)
Default: Anonymous

<sip:no_from_info@anonymous.invalid>"

Maximum SIP Sessions

Indicates the maximum number of concurrent session initiation 
protocol (SIP) call control sessions. Set this value to a number 
that at least doubles the number of channels in the system 
because the system can be tearing down a call while processing 
the next call.  Setting this to a value higher than the number of 
channels licensed for the SR140 virtual module will not increase 
the number of simultaneous faxes that the SR140 can 
send/receive. Valid values are:
Range: 1 through 65535
Value Type: decimal
Default: 256
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Phone Number

Indicates the value used for the p= line in the SIP SDP. The p= 
line identifies the phone number to associate with the session. 
Phone numbers use the conventional international format: the 
number preceded by a + (plus symbol), the country code and a 
space or hyphen character. For example: 
+1 408-370-0881 So, please set this to the externally published 
phone number for the SR140 virtual fax module. Valid values are:
Range:1 - 255 characters
Value Type: character string (up to 256 characters)
Default: <blank> (empty string)

Primary Proxy Server

Additional Proxy Server #2

Additional Proxy Server #3

Additional Proxy Server #4

Indicates the address of the specified SIP proxy server. Define a 
maximum of 4 proxy servers. Valid values are:
Domain name Indicates the name or IP address of the proxy 
server.
Range: 1 - 4 proxy servers specifying any valid domain 

name (for example, www.my_sip_server.com or 
192.168.1.45)

Value Type: character string (up to 256 characters)
Default: <blank> (empty string indicating no proxy server 

defined)
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Primary Registrar Server 

Additional Registrar Server #3

Additional Registrar Server #4

Additional Registrar Server #4

Indicates the address of the specified SIP registration server. The 
user can define a maximum of 4 registration servers. Valid values 
are:
Domain nameIndicates the name or IP address of the registration 

server (up to 256 characters).
Range: 1 - 4 registration servers specifying any valid 

domain name (for example, 
www.my_registration_server.com or 
192.168.1.45)

Value Type: character string (up to 256 characters)
Default: <blank> (empty string indicating no registration 

server defined)

Session Description

Indicates the value used for the i= line in the SIP SDP. The i= line 
provides a textual string that describes the session's purpose or 
provides information about the session. Valid values are:
Range: 1 - 255 characters
Value Type: character string (up to 256 characters)
Default: <blank> (empty string)

Session Name

Indicates the value used for the s= line in the SIP SDP. The s= 
line provides a textual string that gives a name to the session. 
Valid values are:
Range: 1 - 255 characters
Value Type: character string (up to 256 characters)
Default: no_session_name
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Username

Indicates the name inserted into the o= line in the SIP session 
description protocol (SDP). The o= line defines the owner or 
creator of the session and the session identifier. This value must 
not contain spaces. Valid values are: - (dash) = A dash or hyphen 
character indicates the absence of an owner name or session ID.
Range: 1 - 255 characters
Value Type: character string (up to 256 characters)
Default: - (dash or hyphen character)
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IP Parameters Tab for 
H.323 Stack

When you select an H.323 stack to configure, the IP Parameters tab 
allows you to set values for the following parameters (see example on 
page 124). Most of these parameters only need to be configured when 
you have a gatekeeper in your local network. However, if you have 
multiple NIC cards in your system, and you don't want to use the 
first NIC card for the H.323 traffic, you need to set the static (fixed) 
IP address of the NIC card you want to use for the H.323 messages 
in the h323_local_ip_address field. This IP address will typically be 
the same as the IP address selected under Media IP Interface in the 
IP Parameters tab under the SR140 module, which selects the NIC 
card for the FOIP traffic. If not set, it will take the IP address of the 
first Ethernet interface (NIC card) in the chassis. If you don't have 
an H.323 gatekeeper, you have to set h323_default_gateway when 
your application isn't setting this already.

Primary Gateway

Indicates the IP address of a default gateway to use for outbound 
calls. If you only specify a phone number when making an H.323 
call and the application is not using an H.323 gatekeeper, the Bfv 
API forwards the call to the gateway specified with this 
parameter. The Bfv API forwards the specified phone number to 
the gateway for routing purposes. When set, this field must 
contain an IP address in the form: xxx.xxx.xxx.xxx:PortNumber 
(Port number is optional)
Examples
10.128.22.6:1720 (port number specified)
10.128.22.6 (no port number specified
Note: For the H.323 protocol, the port defaults to 1720 if not 

specified.
Range:0 – 255 for each dotted decimal position of the IP address.
1 – 65535 for the port number
Value Type:dotted decimal
Default:0.0.0.0:0 
Note: The Bfv API does not use this parameter if the 

configuration file specifies a value of 1 for the h323_register 
parameter.
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E.164 Aliases

Specifies the E.164 alias of the H.323 terminal. This alias is used 
during gatekeeper registration and call establishment. It 
identifies the phone number of the H.323 terminal.
You can specify multiple aliases, each starting on a new line using 
the same parameter name. For example:
h323_e164alias 123456

h323_e164alias 4084839648

h323_e164alias 5102987468

h323_e164alias 9627842899

When you specify multiple values, the system registers every 
value with the gatekeeper.
Valid values are:
Range:1 - 128 characters (inclusive)
Value Type:character string restricted to numbers 0 through 9 

and the star (*) and pound (#) symbols
Default:<blank>

Gatekeeper ID

Specifies the ID of the H.323 gatekeeper that the H.323 terminal 
will attempt to find during the gatekeeper discovery routine. If 
you do not set this parameter, the H.323 terminal will attempt to 
register with the first gatekeeper it finds. Valid values are:
<blank> = Uses the first gatekeeper the H.323 terminal locates.
Value Type:Unicode character string (up to 256 characters)
Default:<blank>
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Primary Gatekeeper

Fallback Gatekeeper #2 

Fallback Gatekeeper #3 

Fallback Gatekeeper #4 

Fallback Gatekeeper #5 

Fallback Gatekeeper #6

Specifies the IP address of up to six H.323 gatekeepers that will 
receive the registration request from the H.323 terminal. If you 
leave this parameter blank, the H.323 terminal will perform a 
multicast gatekeeper discovery routine to find the gatekeeper 
using port number 1719. Valid values are:
xxx.xxx.xxx.xxx Configures the system to use the specified 

H.323 gatekeeper. Set the gatekeeper IP 
address in the form:
xxx.xxx.xxx.xxx:PortNumber

0.0.0.0:0 Configures the system to use a multicast 
process to discover the H.323 gatekeeper 
using port number 1719.

Range: 0 – 255 for each dotted decimal position of 
the IP address.
1 – 65535 for the port number

Value Type: dotted decimal
Default: 0.0.0.0:0 (uses multicast discovery 

process and port number 1719)

Gatekeeper Time to Live

Specifies the number of seconds to allow between registration 
request messages sent from the H.323 terminal to the gatekeeper. 
After reaching this limit, the H.323 terminal generates another 
registration request to the gatekeeper because the previous 
request is now considered invalid. Valid values are:
Unit:second
Range:0 - 32,000,000 (0 means that gatekeeper registrations 

do not expire; 32,000,000 seconds equals one 
calendar year)

Value Type:integer
Default:0
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Local H.323 Terminal ID

Specifies the H.323 ID of the H.323 terminal. This alias is used 
during gatekeeper registration and call establishment. It 
identifies the name of the H.323 terminal. You can specify 
multiple aliases, each starting on a new line using the same 
parameter name. For example:
h323_h323IDalias andrew

h323_h323IDalias bob

h323_h323IDalias charles

h323_h323IDalias david

When you specify multiple values, the system registers every 
value with the gatekeeper. Valid values are:
Range:Up to 256 characters
Value Type:Unicode character string
Default:<blank>

Local IP Address

Specifies the transport address of the H.323 terminal. The 
transport address can be an IP address or a combination of the IP 
address and the port number that the H.323 call control stack 
uses. If you do not provide an address, the system uses the IP 
address of the first Ethernet interface (NIC) in the system and 
port number 1720. Here, you typically want to set the same IP 
address as the one selected under the Media IP Interface 
parameter in the IP Parameters tab under the SR140 module. 
Valid values are:
xxx.xxx.xxx.xxx Configures the system to use the specified 

IP address for H.323 calls. Set the 
transport address in the form:
xxx.xxx.xxx.xxx:PortNumber

0.0.0.0:0 Configures the system to use the address 
of the first Ethernet module and port 
number 1720.

Range: 0 – 255 for each dotted decimal position of 
the IP address.
1 – 65535 for the port number

Value Type: dotted decimal
Default: 0.0.0.0:0 (uses first Ethernet module 

and port number 1720)
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Name of Manufacturer

Specifies a string naming the H.323 terminal’s manufacturer.
Range:Up to 256 characters
Value Type:Unicode character string
Default:"Dialogic Corporation"

Manufacturer Code

Specifies a code that identifies the manufacturer of the H.323 
terminal making the call.

Range:0 – 255
Value Type:decimal
Default:48
Note: 48 is the H.323 manufacturer code for Dialogic 
Corporation.

Maximum H323 Sessions

Indicates the maximum number of concurrent H.323 calls that 
the host module can support at one time. Set this value to a 
number that at least doubles the number of channels in the 
system because the system can be tearing down a call while 
processing the next call. Setting this to a higher value will not 
increase the number of simultaneous fax calls that have been 
licensed. Valid values are:
Range:1 through 65535 (inclusive)
Value Type:decimal
Default:256

Register with Gatekeeper

Specifies an integer value that determines whether to register 
with an H.323 gatekeeper. Valid values are:
0 = Does not register with an H.323 gatekeeper.
1 = Registers with an H.323 gatekeeper.
Value type:integer
Default:0
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Support Alternate Gatekeepers

Specifies whether to support alternate gatekeepers. The 
gatekeeper receiving the registration request from the H.323 
terminal must also support alternate gatekeepers.
When the H.323 terminal sends a registration request to its 
primary gatekeeper, the primary gatekeeper will send the H.323 
terminal a list of alternate gatekeepers that it knows about. If, for 
some reason, the H.323 terminal can no longer communicate with 
its primary gatekeeper, it will go through the list of alternate 
gatekeepers and attempt to register with them.
When alternate gatekeepers are not supported and the H.323 
terminal can no longer communicate with its primary gatekeeper, 
it will go through the multicast gatekeeper discovery routine to 
find an available gatekeeper. Valid values are:
0 = Does not support alternate gatekeepers.
1 = Supports alternate gatekeepers when necessary.
Value type:integer
Default:0

T.35 Country Code

Specifies a code identifying the international country that 
manufactured the H.323 terminal making the call. The code 
allows other H.323 terminals to know the origin of the H.323 
terminal. The ITU-T Recommendation T35 Annex A lists the 
country codes used for H.323 Non-Standard Facilities (NSF).
Range: 0 - 255
Value type:decimal
Default:181
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T.35 Country Code Modifier

This parameter specifies a modifier for the country code of the 
vendor’s H.323 terminal making the call. If the T.35 country code 
is defined as hexadecimal FF, this extension value defines a two-
byte manufacturer country code.
0 = Does not support alternate gatekeepers.
1 = Supports alternate gatekeepers when necessary.
Value type:integer
Default:0
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T.38 Parameters Tab for 
SIP Stack

The T.38 Parameters tab for a SIP stack allows you to set values for 
the following parameters. These parameters should work without 
being modified.

T.38 Parameters for H.323 
Stack

The T.38 Parameters tab for an H.323 stack allows you to set values 
for the following parameters. These parameters should work without 
being modified.
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RTP Parameters for SIP 
Stack

RTP Parameters for H.323 
Stack
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Returning to the Default Configuration

 To return to the default configuration, follow the 
instructions below:  

1. While in the Advanced Mode, click on Options->Preferences. Note 
the location of the following files:

 The btcall.cfg in the BTCall Configuration field.

 The callcnt.cfg in the Call Control Configuration field.

2. Exit from the Configuration Tool.  

3. Delete either the btcall.cfg or the callcnt.cfg or both based on 
what you would like to reset. 

4. Next start the Configuration Tool again. 
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5 - Testing Dialogic® Brooktrout®
SR140 Software and

TR1034/TruFax® Boards

This chapter explains how to use Dialogic® Brooktrout® Fax/Voice 
Diagnostic Test Tool (FDTool) for Windows SDK to test the 
following:

 Dialogic® Brooktrout® SR140 Fax Software

 Dialogic® Brooktrout® TR1034 Series and Dialogic® 
Brooktrout® TruFax® boards

You must have installed the SR140 license file and therefore your SR140 
virtual module, before you continue here with configuration and testing. 
See Activating Dialogic® Brooktrout® SR140 Software on page 26.

If you ISV’s application does not contain the FDTool, you can 
download a copy from the Dialogic Technical Services and Support 
website. See Getting Technical Support on page 12 and download the 
FDTool that supports your Brooktrout software version. 

See Returning to the Default Configuration on page 128 to get the 
version of your Brooktrout software.

Also at the website you will find White Papers and Frequently Asked 
Questions besides Downloads. Dialogic recommends that you look on 
this site under the SR140 product and FOIP/T.38.
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If you have already installed your LAN Fax application, you might want to 
first use the LAN Fax application to test your boards. If your application 
functions properly, then you do not need to use this FDTool.

You can test a maximum of 8 channels simultaneously on the 
FDTool Diagnostic Tool in a Windows operating system. See 
Installing the FDTool on page 131.  

This chapter covers the following major topics:

 Installing the FDTool on page 131

 Menus and Submenus on page 132

 Generating Logs for Troubleshooting on page 139

Refer to Dialogic® Brooktrout® SR140 Software and 
TR1034/TruFax® Specifications on page 141.
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Installing the FDTool 

This section describes how to install and configure the FDTool and 
generate log files.

 You might have received the FDTool as part of your fax 
application. If not, download a self-extracting zip file from 
the web by following the steps below:

1. Go to the following Dialogic website 
http://www.dialogic.com/support/helpweb/default.aspx/TR1034

2. Under Troubleshooting select How to download and use the 
Dialogic Brooktrout Fax Diagnostic Tool for Windows.

3. Locate the FDTool for your version of the software. See Getting 
Help From the Dialogic® Brooktrout® Configuration Tool on 
page 96 to get the version of your Brooktrout software.  Below 
FDTool for SDK of your version, select Download.

4. Save the zip file to an empty directory and unzip it.

5. Extract the files to the current directory.

6. To launch the FDTool, double-click the fdtool.exe icon. 
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Menus and Submenus 

The following table lists the menus and submenus of the FDTool.

Table 3.   FDTool Menus and Submenus

Menus Submenus

File  Configure - Launch the Configuration 
Tool to configure your telephony

 Initialize - Initialize FDTool with the 
selected module

 Exit - Exit FDTool
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Tool  Debug - Enables/Disable the Brooktrout 
API logging.

 VTTY Tracer - Launch the VTTY Tracer 
utility for logging PSTN.

 Reset Alarm Counters - Resets the 
counters maintained by FDTool.

 Reset Configuration - Clears out the 
configuration files created with the 
Configuration Tool. The Configuration 
Tool would need to be run again by 
clicking on the Configuration button 
before the FDTool can be used again. It 
resets the whole configuration.

 Send Multipage TIFF - Usually only a 
single-page TIFF file is used for sending 
faces with the FDTool. Selecting this 
option sends out a three page TIFF file 
that alternates the fax resolution from 
fine to normal - bank to fine.

 Reject Incoming Calls - If this is 
selected, incoming calls will not be 
answered. The utility would only be able 
to place outbound calls.

 Start Interop Test Suite - Run a set of 
tests for inter-opting with other devices. 
In order to run an interop SR140 license is 
required.

Help  Help - disabled

 About fdtool… - Provides version 
information.

Table 3.   FDTool Menus and Submenus

Menus Submenus
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Running the FDTool

 Follow the steps below to run the FDTool.

1. From the FDTool screen click the Configure button to launch the 
Configuration Tool. 

2. Refer to the Returning to the Default Configuration on page 128 
for instructions for using the Configuration Tool. 

3. After successfully configuring the system and closing the 
Configuration Tool, FDTool will list the available modules.
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4. Click Initialize. The following screen appears.

5. If there are more than eight SR140 channels, the information 
bubble above appears. If not, the following screen appears.
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6. The following screen indicates that you have entered a dial string.

7. Select a channel configured with a Dialstring to enable the Dial 
button. Click Dial to start the outgoing fax.
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8. The following screen indicates that the fax is being sent between 
two channels.

9. The following screen displays the history information for the first 
channel.
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10. Click on the second channel to display the history information for 
that channel.

11. To enable logging, click Debug from the Tools menu.

12. Click Help, About fdtool and the following screen appears:  
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Generating Logs for Troubleshooting 

FDTool creates various log files for troubleshooting. All logs are 
created in the logs directory where the FDTool is located. The log 
history for each channel is saved in a file porthistory_xx.log where xx 
is the channel number displayed in FDTool. The log history is the 
output displayed in FDTool for each channel.

Additional logging can be enabled from FDTool's Tools menu:

 Debug

 VTTY Tracer

Additional logging can be enabled under the direction of Dialogic 
Technical Services and Support.

 Debug Enabling logging with Tools | Debug will cause the Dialogic® 
Brooktrout® API to start logging continuously. This is the most 
common logging requested by Dialogic Technical Services and 
Support. Enabling Debug logging will generate logs to the following 
files:

 apidbug_systemlog

 apidebug_unit_xx.log

VTTY Tracer VTTY Tracer is a separate logging utility for PSTN boards. It can be 
launched from the menu of FDTool, Tools | VTTY Tracer.  

When launching the VTTY Tracer utility the following instructions 
will be displayed in a dialog box. 
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Click OK, then follow the direction displayed in the dialog box. If 
enabled successfully, the output may appear as follows.

Other Tools Options There are three other options under the Tools menu:

 Reset Configuration - clears out the configuration files created 
with the Configuration tool. The Configuration tool would need 
to be run again by clicking on the Configuration button before 
the FDTool can be used again. It resets the whole configuration.

 Send Multipage TIFF - Usually only a single-page TIFF file is 
used for sending faces with the FDTool. Selecting this option 
sends out a three page TIFF file that alternates the fax 
resolution from fine to normal - bank to fine. 

 Reject Incoming Calls - If this is selected, incoming calls will not 
be answered. The utility would only be able to place outbound 
calls.
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6 - Dialogic® Brooktrout®
SR140 Software and

TR1034/TruFax® Specifications

Fax
 ITU T.30; ITU T.38; IETF RTP; Group 3

 ASN.1 (2002)

 V.17, V.29, V.27ter, V.21, V.34 modulation

 Up to 33.6 Kbps with auto fallback 

 Normal and fine resolution: 1200x1200

 MH, MR, MMR compression

 Transparent image conversion

 A4, A3 and B4 page sizes with scaling

 A4 and B4 TIFF F file widths

 Enhanced ASCII conversion support with headers

 Error Correction Mode (ECM)

 Line error detection/repeat good line

 G.711 pass-through
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RTP
 G.711 20ms and 30ms Packets

Voice
 Prompt Playback

 Prompt Record

 Playback Gain Control

 Inbound and Outbound Silence Suppression

 Dynamic Range Control

 High Frequency Preemphasis

Signal Generation/Detection
 G.711 Single Frequency Tone Generation

 G.711 DTMF Tone Generation

 G.711 DTMF Tone Detection 

 Adaptive Call Progress Analysis
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System Requirements
Minimum System 
Requirements

The minimum system requirements for running any number of 
SR140 channels is a Pentium P4 2.66 GHz with 512MB RAM. Refer 
to the System Configurations section of the Dialogic® Brooktrout® 
Release Notes for a table describing the CPU utilization for this and 
other system types.

Supported and Tested Devices for Interoperability
For the latest listing of Dialogic® Brooktrout® FoIP interoperability 
information refer to the following site:

http://www.dialogic.com/interoperability/fax.htm

This list includes the following hardware devices (and their 
respective software revisions) that have been tested for 
interoperability with the SR140 Fax Software:

 IP PBX

 Gateways

 Other devices

Telephony Requirements
 Physical: Ethernet 10/100

 Media  T.38, RTP v2, G.711

 Call Control: 

 IP: H.323, SIP

 PSTN: Analog, DID, BRI, T1, E1
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Operating Systems
 Windows Server 2016 64-bit

 Windows Server 2012 R2 64-bit

 Windows Server 2012 64-bit

 Windows Server 2008 R2 64-bit

 Windows 10 Enterprise Edition 32-bit and 64-bit

Installation and Configuration
 Windows Graphical Configuration Tool

Application Programming Interface
 Dialogic® Brooktrout® Fax and Voice (BFV)
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Dial String Formats
Dial strings (phone numbers) may be up to a maximum of 255 
characters.

PSTN Telephony

The dial string field supports the following digits and control 
characters. Invalid characters are ignored; upper and lower case 
letters are equivalent. Some protocols ignore control characters 
and only accept DTMF characters.
Valid Digits and Control Characters

Note: In an analog environment or when using a T1 robbed bit 
FXS loopstart or E1 CAS loopstart protocol, the ‘w’ character 
means wait for dial tone. All other protocols ignore the ‘w’ and 
‘i’ characters. Only analog environments and T1 robbed bit or 
E1 CAS protocols use the ‘p’, ‘t’, comma and semicolon 
characters.

0 - 9 Dials digits ‘0’ through ‘9’.

# (pound) Dials a pound.

* (asterisk) Dials an asterisk.

A - D Sends the DTMF tone corresponding to the 
specified alphabetic character. 

p Changes the current or default dialing mode 
from tone dialing to pulse dialing.

t Changes the current or default dialing mode 
from pulse dialing to tone dialing.

w Waits for dial tone.

, (comma) Causes a 1-second pause.

; (semicolon), 
i or I

Causes a 5-second pause. To create longer 
pauses, string any of these characters 
together.

! (exclamation point) Sends a hook flash on analog and T1 robbed 
bit modules.
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IP Telephony

For IP outbound calls using the H.323 protocol:
 Phone#@IP Address:Port# 

If the receiving side does not require a phone number, a value 
for Phone# is optional. Also, :Port# is optional — the Bfv 
API uses 1720 as the default port value.

 TA:IP Address:Port#,Phone#

:Port# is optional — the Bfv API uses 1720 as the default 
port value. If the receiving side does not require a phone 
number, a value for Phone# is optional.

 Name:<name of person to dial>

Use this form only if using gatekeeper
 E164alias:7894561234

Use this form only if using gatekeeper
Note: DNS lookups are not supported in H.323. You can use an 

H.323 or E.164 alias in conjunction with a gatekeeper to 
provide similar functionality.

Examples 
4082345555@10.155.89.6:175
4082345555@10.155.89.6

TA:10.155.89.6:175,4082345555
TA:10.155.89.6,4082345555
TA:10.155.89.6

Name:Fred Smith
E164alias:4082345555

For IP outbound calls using the SIP protocol:
Phone#@IP Address:Port#  

If the receiving side does not require a phone number, a value for 
Phone# is optional. Also, :Port# is optional - the Bfv API uses  
5060 as the default port value.

Examples  (IPv4 Addresses) 
4082345555@10.155.89.7:175
4082345555@10.155.89.7
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Examples  (IPv6 Addresses)
4082345555@[2000::2ef3:1dff:ea3]:175
4082345555@[fe80::1f4:189c:74da:69f7]

Note: IPv6 addresses must be enclosed in brackets.  In addition, if a 
link-local IPv6 address is specified, the Scope ID should be 
omitted from the address.

DTMF Post Dialing
For all types of IP calls, the character '&' (ampersand) may be 
included to initiate post-dialing. This character indicates that the 
rest of phonenum specifies a sequence of DTMF digits to be "post-
dialed" after messages from the remote side indicate the call is 
proceeding towards connecting.
Within the post-dial string, all dialing characters listed for PSTN 
Telephony are allowed except for 'p', 't', 'w', and '!'. The 
appearance of an additional '&' will terminate processing of the 
string.
Post-dialing of the specified digits will occur upon the first receipt 
of one of the following IP call control messages:
 SIP -- 183 Progress
 SIP -- 200 OK
 H.323 -- Progress
 H.323 -- Connect
The post-dial feature is controlled by the user configuration file 
parameter post_dialing_enable. If the feature is disabled by that 
parameter, then the ampersand has no special effect and the 
entire phonenum field is used as is.

Note: If a program accepts a phone number on the command line, the 
phone number will likely need to be quoted if it contains an 
ampersand, since this is a special character on most OSes. 
(Use double quotes (") on Windows, or single (') or double (") 
quotes on Linux.)
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